
Learning Guide
Animate Photogrammetry Models of People

Introduction
Photogrammetry is a technique that allows a creator to take multiple overlapping photos of a subject and turn the photos into a realistic 3D
model. This technique can also be used to scan people and create 3D models of them. You can then animate these photogrammetry models
and add them to a 3D experience. Combined with other animation techniques, animated photogrammetry models will bring your island in
Unreal Editor for Fortnite (UEFN) to another level!

This Guide will show you how to take a photogrammetry scan of a person using the Polycam mobile app, clean up the resulting 3D model
using Blender, apply animations in Mixamo, and bring the animated model into your own Fortnite island using UEFN.

To achieve the outcomes outlined in this Guide, it is very important that you keep close track of multiple files and use the correct one at each
step. We have provided recommended naming conventions to help you keep track of your files.

Video Learning Guide for this Lesson:
https://www.youtube.com/watch?v=iyWDNp1jLss
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Prior Knowledge Check
To successfully complete this lesson, you should be familiar with the basics of the UEFN User Interface and be comfortable navigating in
UEFN. Take a look at the Unreal Editor for Fortnite User Interface Basics to familiarize yourself with the interface.

You can also use the Epic Games Documentation for more detailed information on the UEFN User Interface.

Getting Started
Make sure you have Blender and UEFN installed on your computer. Create a new project in UEFN and have an island ready to import your
animations into.

https://createaccess.org/foundational-content
https://dev.epicgames.com/documentation/en-us/uefn/user-interface-reference-for-unreal-editor-for-fortnite
https://www.blender.org/
https://dev.epicgames.com/community/fortnite/getting-started/uefn


Step 1: Understand 3D character components

Preview
Using your own character can do a lot to make your 3D experience more unique and engaging. However, 3D characters, by design, have a
lot of components that the creator needs to keep track of. In this section, you will briefly learn about different parts that make up a 3D
character and how they work.

Experiment

CHARACTER MODEL

A 3D model is the 3D representation of your character on
screen. You can think of the model as the "sculpted body”
of your character. The model can include detailed facial
features, clothes, hair, etc. But it cannot be animated to
move like a human without a skeleton, and will look plain
gray without any textures added.

TEXTURES

Textures are image files that define color, detail, or other
surface information of a 3D model. A texture can also
define how the surface of a model reacts to light (shiny,
dull, metallic, etc.). By adding textures to your character,
you can visualize the color and details of the hair, skin,
clothing, etc. When you do a photogrammetry scan of a
person, the textures will be created along with the model.



SKELETON AND BONES

Just like the human body, 3D characters have a collection
of bones and joints inside them that form a skeleton.
As mentioned above, 3D character models cannot be
animated to move their limbs like humans until they have
skeletons.

With the skeleton, each joint can be animated to move the
corresponding parts of the body. Creators can animate
their 3D characters by animating every single joint by
hand, or they can use 3D animation libraries like Mixamo
that will create a skeleton for a character automatically and
allow the creator to decide how to animate it by providing a
library of options.

ANIMATION FILES

It is important to keep in mind that animations and
skeletons are closely linked together. When you download
an animation file online or create your own animation for
“Character A”, that animation will be dependent on the
skeleton of “Character A.” This means that the same
animation file cannot be used on a different character – for
example, “Character B”.

https://www.mixamo.com


Step 2: Create a photogrammetry model with Polycam

Preview
The first step in animating your own realistic character is to scan yourself or someone else to create a photogrammetry model. Download the
Polycam app on your phone and follow the instructions to create your own 3D model of a person.

Experiment

SCAN A PERSON

Pick a well-lit environment without any harsh lighting or
shadows. If you would like to create a model of yourself,
you will need the help of another person to scan you.

The subject of the scan should stand in A-pose, feet
shoulder width apart and arms down at a 45 degree angle.

While scanning, make sure the subject stands as still as
possible throughout.

For best results, the person being scanned should wear
clothing with different details and textures, instead of plain
colors. If the subject has long hair, it’s suggested that they
tie it because long and loose hair is harder to scan
accurately.

https://poly.cam/library


Open the Polycam app on your device and click on the
camera icon in the bottom right corner to start a new scan.

Keep in mind that the app interface might look different
depending on the device being used. However, the
process is generally the same. This Guide will be showing
examples from an iOS device.

If you’re using Polycam for the first time, switch to Manual
Mode to ensure you can take photos at your own pace.

Before starting the capture, make sure the app is in Photo
Mode.



Use the plus icon in the middle of the screen to start
taking pictures of your subject.

Start with a full view of the person you’re scanning and
walk around them while taking pictures in small
increments. Each picture should overlap about 50% with
the one before it.

After doing one full turn, take more pictures from different
angles, including the top and bottom. When you cover all
angles, make sure to do some close-ups. The more
pictures you take, the more accurate and detailed the final
3D model will be.



Take anywhere between 20-150 pictures. When done, click
on Done in the Polycam app.

Select Upload & Process at the bottom of the screen and
wait for your model to be processed, which might take a
few minutes. Keep the app open while processing.



When the process is complete, you can download the 3D
model to your computer from the poly.cam website.

Log into your account and go to your Library. Click on
your scanned person model to view and download it.

Click on the download icon at the top of the screen.

Select the GLTF file format option and click on Export to
download your model. It will be automatically downloaded
to the “Downloads” folder on your computer.

We recommend locating the file and naming it
“[file-name]_preBlender”
(for example: MyAvatar_preBlender.gltf)

Self Check
Were you able to successfully scan a person and view the 3D model you created on the Polycam website?

https://poly.cam/library


Step 3: Edit your model in Blender

Preview
More often than not, the 3D models from a photogrammetry scan are not immediately ready to use. By doing some “clean-up” in Blender,
you can delete any floorground or surrounding area captured during the scan.

Experiment

OPEN YOUR MODEL IN BLENDER

Blender is a free 3D creation suite that is commonly used
in industry. Blender is a versatile tool that can be used in
many areas of 3D creation, but for this lesson, you will
need it briefly to clean up your model and change its file
format.

Download Blender and follow the prompts to install it on
your computer. Once installed, launch Blender and select
General from the New File options.

https://www.blender.org/download/


To navigate in the Blender viewport, hold down the SHIFT
key and Middle Mouse Button together and move your
mouse.

To rotate around an object, hold down Middle Mouse
Button and move your mouse in the viewport.

To zoom in or out, use the scroll wheel on your mouse or
hold down CTRL and use the Middle Mouse Button.

To move an object in the scene, you can enable the arrow
gizmos by selecting the “Move” icon from the left panel.

You will see some default objects (cube, camera, light) in
the Blender scene that opens. You can delete these
objects since they’re not needed.

Click on the “A” key to select everything in your scene
and press Delete (or the “X” key) to clear the scene.



Import your photogrammetry model into Blender by
selecting File > Import > .glb/gltf, and then navigate to
the folder where the model was downloaded to your
computer from the Polycam website.

The file should have been named
“[file-name]_preBlender”.

Your character model will appear in the Viewport. If the
model appears gray, you can enable the textures and
colors on the viewport by clicking the Viewport Shading
icon on the top-right corner.

Deselect everything by clicking an empty space in the
Viewport away from your model.



Enter Edit Mode from the “Object Mode” dropdown in the
top menu bar to start cleaning up your model.

There are a few different tools you can use to select the
larger areas on your model to delete them. From under the
Select menu option, try using the Box Select or Circle
Select tools on your model.

Click and drag the box or circle on your model to select the
area you want to delete.



Press the Delete or “X” key on your keyboard to delete
the area. From the pop-up, choose Vertices.

Repeat this process as much as you need to get rid of the
unwanted areas surrounding your model.



When you’re done, export your character model from
Blender. We will be exporting twice with different file
formats.

First, go to File > Export and select the FBX option. Select
the location you want to export on your computer and
name this file “[file-name]_preMixamo”
(for example: MyAvatar_preMixamo.fbx).

This file is the clean version of your character that we will
use in the next step to add bones to, in order to animate it
in Mixamo.

Second, select the GLB/GLTF option. Select export
location, and name this file “[file-name]_texturesOnly”
(for example: MyAvatar_texturesOnly.glb)

This file will be used later in UEFN to apply textures and
colors to your character on your island.

Self Check
Could you clean up your model as you wish? Were you able to export it from Blender in different file formats?



Step 4: Select animations in Mixamo

Preview
After creating and cleaning a photogrammetry model, you now have a 3D model with textures. There are a few more steps to complete
before animating your model and making it move. This section will help you select an animation to apply to your character in Mixamo and get
it ready for import into UEFN.

Please carefully note all the different file types and suggested naming conventions in this section.

Experiment

UPLOAD TO MIXAMO

Go to mixamo.com and sign up for free using your email.

You will see an avatar on the right and animation
thumbnails on the left. We need to upload our
photogrammetry character to the viewport on the right.

Click the Upload Character button on the top-right, and
select your “[file-name]_preMixamo.fbx” file exported from
Blender.

Once it’s uploaded, hit Next.

https://www.mixamo.com/#/


RIGGING THE MODEL

After uploading your model, position the colorful circles
onto your character to represent the locations of joints by
clicking and dragging them to the appropriate locations.
You will see an example on the right side of your screen
that shows where to place each marker.

Click Next to have Mixamo rig the model. This process
might take a few minutes. When done, click Next again.

Before selecting any animations from the left menu, click
the Download button on top-right. Keep the default format
at “FBX Binary” and select “Original Pose”.

Click Download again and the character model will
download automatically to your “Downloads” folder. Find
the file on your computer and rename it.

We recommend naming the file “[file-name]_Bones”.
(for example: MyAvatar_Bones.fbx)



Explore the animations in Mixamo’s library by clicking on
the thumbnails on the left window. You will see the
animation play on your character on the right screen.

When you’re happy with your animation choice, click on
the Download button on the top-right of your screen.

Keep most settings on default. For the “Skin” option, select
“Without Skin”. This will download an animation data file
without including the character model.

The file will download automatically to your computer. Find
the file in your “Downloads” folder and rename it.

We recommend naming this file
“[file-name]_[animation-name]”.
(for example: MyAvatar_Walking.fbx)

Even if you follow your own naming conventions, make
sure to name your files to be able to differentiate between
them.

Self Check

Were you able to download all the files from Mixamo and rename them as suggested? Which animation did you pick for your character?



Step 5: Combine in UEFN

Preview
The final step of animating your avatar is compiling all the files in UEFN and bringing your avatar to life! Make sure all of your files are ready
to go and are named appropriately. It is very important to use the correct files while compiling your animation in this step.

Experiment

IMPORT ALL FILES

Open UEFN and create or open a project.

To begin, create three folders in your Content Drawer by
right clicking on an empty area. These will help you keep
track of the files you import. Name them:

● Animations
● Bones
● Materials

Open the “Materials” folder and import the .glb file named
“[filename]_TexturesOnly”. This file will be used
exclusively for the materials (colors and textures) of your
character.

You will not be using the “Mesh” or “Skeletal Mesh” files in
this folder, because you have another file for the “body” of
the character.



Open the “Bones” folder and import the
“[file-name]_Bones” .fbx file from Mixamo.

On the import screen, make sure no skeleton is selected.
Under the Mesh section, the Skeleton option should say
“None”.

If this option is pre-populated with a skeleton, you can
deselect it by clicking the small return arrow next to the
dropdown.

Scroll down to the Material section and make sure you
select “All Assets” under Search Location. With this, the
model will be able to find the materials you imported
previously to the “Materials” folder.

When done, click on Import All.



Next, open the “Animations” folder. This is where the
animation files will be imported.

Click on “Import” and select your animated FBX files from
Mixamo named “[file-name]_[animation-name].”

In the Mesh tab, next to the Skeleton option, make sure
to select the skeleton that you’ve downloaded from
Mixamo with the “[file-name]_Bones” name. The name of
the file should automatically match the name of the
skeleton.

Select Import All when done.

In the “Bones” folder, drag the Skeletal Mesh asset onto
your island. This asset will be underlined in pink in the
thumbnail.

This asset is just the skin and bones of your character and
does not have animations yet.



Select your skeletal mesh in the Viewport and go to the
Details Panel.

Under the Animation tab, find “Anim to Play.” Open the
dropdown and select the animation you want to apply to
your character.

Your avatar skeletal mesh will be positioned to the first
frame of the animation but will not move in the Viewport.

To see the animation play in realtime, Launch Session
and open your island in Fortnite.

Self Check

Could you animate your avatar in UEFN as you wanted?



Lesson Closure

Demonstration of Learning
You’ve learned how to scan a person with the Polycam app and create a photorealistic model with photogrammetry. You’ve cleaned up your
model in Blender, found animations in Mixamo, and compiled all the files in UEFN. Paying attention to different file types and names, you
animated your photogrammetry character on your own Fortnite island.

Exploration Opportunities
Learning how to animate characters can open a whole new world of 3D creation for you. After understanding the basics of character
animation, you can apply the skills you’ve learned into animating any kind of character you want to have in your 3D experiences.

Take a look at the following Learning Guides to learn how to animate stylized 3D avatars of people or other types of inanimate objects and
cameras in UEFN:

Animate 3D Avatars in UEFN Learning Guide
Animate Assets and Cameras in UEFN Learning Guide

https://www.youtube.com/watch?v=W7fAqA76Ipk
https://www.youtube.com/watch?v=F3Vg_JW7sUg

